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Overview

This book serves as a guide for those interested in using IBM
SPSS/PASW Statistics software to aid in statistical data analysis—

whether as a companion to a statistics or research methods course or as a
stand-alone guide for a particular project or individual learning. The
images and directions used in this book come from SPSS/PASW Statistics
Version 18.0, first released in the autumn of 2009.

What’s the Difference Between 
SPSS Statistics and PASW Statistics? None

There is essentially no difference. The program formerly known simply as
“SPSS” became “SPSS Statistics” with the Version 17.0 release, and then
“PASW Statistics” with the Version 18.0 release. After SPSS, Inc. became an
IBM company in October of 2009, the branding going forward was
changed, so that future releases of the software (Version 19.0 and beyond)
will be known as “IBM SPSS Statistics.” When SPSS was originally devel-
oped, it stood for Statistical Package in the Social Sciences. The motivation
for the PASW (Predictive Analytics Software) branding change was to
reflect the considerable reach of the software to more business-oriented
realms, although this name is used only for Version 18.

Statistical Software

The SPSS/PASW Statistics software works with several kinds of computer
files: data files, output files, and syntax files. Data files are those computer
files that contain the information that the user intends to analyze. Output
files contain the statistical analysis of these data, often displayed as tables,



graphs, and/or charts. Syntax files are computer instructions that tell the
SPSS/PASW Statistics software what to do. Syntax files are not used with
the student version of SPSS/PASW Statistics and are dealt with as an
advanced application in Chapter 12 of this book.

The General Social Survey (GSS) serves the secondary dataset used to
demonstrate typical functions of the program by example. SPSS/PASW
Statistics is the software program, produced by SPSS, an IBM company as
of 2009, in Chicago, Illinois. The GSS is a dataset that is read and analyzed
by the SPSS/PASW Statistics software; it is a data file containing the infor-
mation to be analyzed. The two things are distinct and can be used in sep-
arate contexts without the other.

About the General Social Survey (GSS) Data

The National Opinion Research Center (NORC) at the University of Chicago
administers the GSS. The GSS was started in 1972 and continues to the pre-
sent time. The data used for the examples in this book come from the latest
available completed version of the GSS collected in 2008. According to
NORC, with the exception of the U.S. Census, the GSS is the most frequently
analyzed source of information in the social sciences. NORC acknowledges
that there are at least 14,000 instances where the GSS has been used for arti-
cles in scholarly journals, books, and doctoral dissertations. Further, it is esti-
mated that over 400,000 students annually use the GSS in their work.

The GSS contains many demographic and attitudinal questions, as well
as rotating topics of special interest. A number of core questions have
remained unchanged in each survey since 1972. This allows for rich longitu-
dinal research about the attitudes, opinions, and demographics in the United
States. Topical questions appear sometimes for just one year; other times,
they can appear for a period of years. Therefore, the GSS is versatile as a lon-
gitudinal data resource and a relevant cross-sectional resource.

To maximize the amount of information that can be collected in this
massive interviewing project, the GSS uses a split ballot design, in which
NORC asked some questions in only a random subsample of the house-
holds and asked other questions in other households. Some questions,
including demographic items, were asked of all respondents. When we
begin analyzing the GSS data, you will notice that some data items have a
substantial number of respondents for whom data are marked as missing.
For the most part, this refers to respondents who were not asked that par-
ticular question as a result of the split ballot design.

Although many items were asked of only a subsample of respondents,
you can still take the responses as representative of the U.S. adult noninsti-
tutionalized population, subject to normal sampling error. For more infor-
mation about how the GSS data were collected, see Appendix B, Field Work
and Interviewer Specifications, and Appendix C, General Coding
Instructions, in the General Social Survey 1972–2008 Cumulative Codebook
(Davis, Smith, & Marsden, 2009).
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SPSS/PASW Electronic Files

PASW Statistics 18 (as well as other versions of SPSS Statistics) uses different file
extensions, or endings, and associated icons to signify types of files. For instance,
a file named “file.sav” is a data file called “file.” The “.sav” is used to signify that
this is a data file. Again, data files contain the information that SPSS/PASW
Statistics is used to analyze. A file with the extension “.sps,” is an SPSS/PASW
Statistics syntax file, while a file with the extension “.spv” (or “.spo” for older ver-
sions of SPSS software prior to Version 17.0) is an SPSS/PASW Statistics output
file. Output files contain analyses of data, such things as charts, tables, and other
statistical and data manipulation information. Syntax files contain coded
instructions for SPSS/PASW Statistics to perform operations on data and to
produce output. It is not necessary to create, save, or even deal with syntax files
for most basic SPSS/PASW Statistics functions; therefore, syntax files will be
covered only to the level of description and simple use in Chapter 12.

Opening Existing Data Files

To open an SPSS/PASW Statistics data file that you already have or have
obtained, select the “File” menu, then choose “Open,” and select “Data.” (For
other file types, see the section on importing data from non–SPSS/PASW file for-
mats.) At this point you will need to navigate the disk drives (or network drives
or other sorts of storage devices) to locate the data file that you wish to open.
Once you locate the file, either double click on it, or click on it once and then click
the “Open” button toward the bottom right side of the “Open File” dialog box.
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SPSS/PASW Statistics will then open the data file, and you will be presented
with the information in a grid format (somewhat similar to a Microsoft Excel
or other spreadsheet environment). You have choices about both the way the
information is presented and the information you see. For example, you can
choose to see the Data View, presented in the following image. Here, you are
viewing the actual data. Note that the variables are listed in columns with each
case recorded as a row. The variable “age” has been selected as a reference point.
The data in that column tell the ages of each of the respondents.
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Now, click on the Variable View tab, which is located toward the bot-
tom left of the screen. (Note that the Data View tab is currently selected;
this is the default when opening a new file with SPSS or PASW Statistics 17
or 18.) While the information looks somewhat different, you are still look-
ing at the same data file. See the following image:
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Again, the “age” variable has been selected for reference. In this view,
variables are depicted in rows, with each row showing information about 
a single variable, such as variable label, category label, type, level of mea-
surement, and so forth. You can add to, edit, or delete any of the variable
information contained in this view by directly typing into the cells. This
view does not show the actual response data; to view that you would need
to select the Data View option.

Importing Data From 
Non–SPSS/PASW Statistics File Formats

There is often a need to analyze existing data files that were not created or
formatted by SPSS/PASW Statistics software. These files might be created
by other statistical software packages (e.g., SAS or Stata,) or by other types
of numeric operational programs (e.g., Microsoft Excel). To open these
files, first select the same menu options you would if you were opening an
SPSS/PASW Statistics data file:

FILE � OPEN � DATA

Now, at the “Files of type” prompt at the bottom of the dialog box, click
the arrow at the right to expand the choices. Next, select “Excel (*.xls, 
*.xlsx, *.xlsm).” You will need to navigate your hard drive, other drives, or
other locations to find your file. Once you locate the file, select and open it.
At this point, you will be presented with a new dialog box:



If the column headings in the Microsoft Excel file contain the variable
names, then make sure the box asking to “Read variable names from the
first row of data” is selected. If the column headings are not formatted in 
a way that conforms to the SPSS/PASW Statistics variable-naming conven-
tions, then they will be transformed into permitted variable names, and the
original names will be recorded as variable labels.

To import only a portion of the Excel file, then enter the range of cells
from which you would like to import data.

It is also possible to import files from databases, text files, and other
sources. Follow the same instructions as with Excel files, except for the file
type you select. Depending on the file type you choose, you will be pre-
sented with different dialog boxes or wizards to import the data and
process it for use by SPSS/PASW Statistics.

In some cases, you may simply have unlabeled data in a particular file, or
the variable names or other information may be of little or no use to you. In
that case, depending upon the size of the file, you could copy the data from
the original numeric program (e.g., Microsoft Excel), and then paste it
directly into the SPSS/PASW Statistics Data View window. This is particularly
useful if you just want to add numeric values from another source and enter
or program the other information using SPSS/PASW Statistics.

Opening Previously Created Output Files

In order to open a previously created output file, select from the “File”
menu as follows:

FILE � OPEN � OUTPUT

You will be presented with the following dialog box:
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Here, just navigate to find your file, as you would any other type of
file. Once you locate it, select and open the file. SPSS/PASW Statistics will
open the file into an Output Viewer window. There, you can view and edit
it. Note that Version 18 (as well as Versions 16 and 17) of SPSS/PASW
Statistics uses the *.spv file extension. Earlier versions of SPSS software
employ the *.spo file extension. SPSS/PASW Version 18 is capable of open-
ing output files created with older versions of SPSS software, but files cre-
ated in the new version can not necessarily be opened in the older
versions.

Saving Files

All types of SPSS/PASW Statistics files are saved in virtually the same way
as files in any modern computer program. Select either

FILE � SAVE to save the file as the currently assigned name,

or

FILE � SAVE AS to save the file in a different file, 
under a new name.

The first option above will automatically save the file without
prompting you for a dialog box, unless you are working with a new, yet
unnamed, file. In that case, you will get the same type of dialog box as
though you had selected the “Save As” option. If you do choose the second
option, you will be given a dialog box prompting you to name the file and
to select the location on your computer or network where the file is to be
placed.

Creating New SPSS/PASW Statistics Data Files

To create a new SPSS/PASW Statistics data file, select the “File” menu; then
choose “New,” and select “Data”:

FILE � NEW � DATA

You will then be presented with a blank Data Editor window like the
one following.
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You can immediately start entering information related to the variables you
wish to create and/or the actual data codes that you may have. In the Data Editor
window that follows, the Variable View tab has been selected and information
has been entered for two variables: AGE and SEX. Notice that the labels have
been entered: “Respondent’s age” and “Respondent’s sex,” respectively. Other
information about the variables has been selected and entered, as well.
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For the SEX variable, value labels have been entered. This was done by
clicking on the “Values” cell for that variable and then selecting the button
with three small dots. The following dialog box would have appeared.



In the “Value Labels” box, you can enter the label for each of the category
codes for the variable. In this case, “0” was entered in the “Value” box, while
“female” was entered into the “Label” box. At that point, to record the infor-
mation, it is necessary to click the “Add” button. Notice, also, that “1” was
entered into the “Value” box and “male” was entered into the “Label” box, and
again, the “Add” button was clicked. (This procedure also produces a dummy
variable called “male,” where the value of 1 is male, and 0 is “not male.”) By
doing this, we are assigning numbers to the categories of the variable, SEX, so
that SPSS/PASW Statistics knows how to record whether the respondent is
male or female; the software uses numbers to keep track of those attributes. By
using numbers, the software can track the categories and use that information
to perform statistical operations such as those described throughout this book.

It is also possible to enter the data directly into the Data Editor. To do this,
click the Data View tab at the lower left of the Data Editor window. The columns
now represent the newly created variables: AGE and SEX. You can directly type the
values for each case or row. You could also copy (<Ctrl> + C in Windows, or
<Apple> + C on a Macintosh) and paste (<Ctrl> + V in Windows, or <Apple>
+ V on a Macintosh) these values from another software program, such as
Microsoft Excel, if you already have them typed categorized by the same variables.
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Notice that the data entered (or pasted) above appear as the numeric
codes that were assigned for nominal and ordinal variables that have those
assignments. There is a way to have the actual label shown in this window.
Click the following from the SPSS/PASW menus, and note the differences
in the screen image below:

VIEW � VALUE LABELS
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Value labels can also be displayed prior to entering data. When you double
click on the right side of a cell, an arrow will appear. If you click on the arrow,
as seen in the screen image above, a pull down menu consisting of all of the
available categories for that variable will appear: In this case, the list consists of
“female” and “male.” If you are entering data directly into SPSS/PASW Statistics,
using this option can make data entry easier and can help avoid error, such as
typos of values that are not within the range of categories for a variable.

Creating and Editing 
SPSS/PASW Statistics Output Files

Output files are created by SPSS/PASW Statistics when you instruct the soft-
ware to perform functions. For example, if you request SPSS/PASW
Statistics to provide frequencies and central tendency values for three vari-
ables from your dataset, then an output file will automatically be produced.
The information that you have requested will be presented in the Output
Viewer window, unless an output file is already open in the Output Viewer,
in which case the new information will be appended to that file. To edit the
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output, you’ll select and double click the part you wish to work with, and
there are tools to facilitate that task. More information on this topic will be
provided in Chapter 4: Organization and Presentation of Information.

Preferences: Getting Started

To change the settings, parameters, and preferences for the SPSS/PASW
Statistics program, select the “Edit” menu and choose “Options”:

EDIT � OPTIONS

You will be given a dialog box like the one shown here:

There are numerous features that can be controlled using this dialog
box, and most are intuitive in their operation. As a user becomes more
experienced, he or she often utilizes more of these features. From the start,
however, most SPSS/PASW Statistics users will want to make sure that vari-
ables will be displayed throughout the program in alphabetical order and
also by name (rather than label). This can be done by selecting the
“General” tab, and clicking the radio buttons for “Display names” and
“Alphabetical.”

This is particularly important if you are using or creating a dataset
that contains a large number of variables, such as the General Social
Survey. While it is clear that alphabetizing the list will facilitate easier



access to variables, listing by name is also crucial, since variable labels are
more detailed and may not necessarily begin with or even use the same let-
ters as the variable name. Changing or verifying these settings up front can
save a good deal of time and frustration. If a dataset is opened and the pref-
erences have not been set to the desired parameters, the user can still go to
the dialog box and make the change while the dataset is open. (In some
older versions of SPSS, it would be necessary to close the dataset, make the
change, and reopen the dataset.)

If you have started a procedure and don’t wish to change the program
preferences as described above, you can do it on the fly. Just right click (or
<Option> + Click for Macintosh computers with a standard one-button
mouse) one or more of the variables from the list shown in the dialog box
with which you are working. You can select “Display Variable Names” and
the “Sort Alphabetically.” Incidentally, you can also select “Variable
Information” for any of the variables (not more than one at a time), which
will provide details about values, value labels, and so forth.

12—USING IBM® SPSS® STATISTICS FOR SOCIAL STATISTICS AND RESEARCH METHODS

Note that this procedure, pictured above, will make the change only in
the current dialog box (including return visits to that same dialog box,
“Frequencies” in this case). You will need to use the same procedure to
organize variables in other dialog boxes, or make the change at the pro-
gram preferences window (EDIT � OPTIONS . . . ). Also, note that this
procedure does not work in all windows (e.g., UTILITIES � VARIABLES,
see next paragraph).

To get a quick overview of the variables in a given dataset, SPSS/PASW
Statistics has a variable utility window to provide useful information about each
of the variables in a way that can be easily navigated (and such that information
can be easily pasted to output if desired). Opening this window will demon-
strate the importance of organized naming and ordering of variables in a large
data file. Choose the “Utilities” menu; then select “Variables”:

UTILITIES � VARIABLES
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When you select a variable from the alphabetized list of variable names
on the left, information about that particular variable will appear on the right
side of the box, including the label, the level of measurement, and the value
labels. This is a fast way to determine what kind of variables are available in
your dataset that are suited to different statistical methods of analysis.

Measurement of Variables 
Using SPSS/PASW Statistics

Whether creating a new data file with SPSS/PASW Statistics or using an
existing data file, it is important to understand how variables have been
measured, or “treated,” by the creator of the data file. This “treatment” is a
factor of how the data were collected—how much information is contained
within the dataset about each variable.

First, it is important to be aware that SPSS/PASW Statistics can record
variables as either string variables or numeric variables. String variables can
consist of letters and/or numbers and cannot be treated numerically; there-
fore, string variables must be treated at the nominal level of measurement.
Numeric variables use numbers to represent response values. These
numbers may represent actual numbers, ranked categories, or unranked
categories. In other words, numeric variables may be nominal, ordinal, inter-
val, or ratio.

In social science statistics and research methods courses, variables are
typically described using these four categories. Many textbooks, such as
Investigating the Social World (Schutt, 2009) or Adventures in Social Research
(Babbie, Halley, Wagner, & Zaino, 2010) elaborate all four of those cate-
gories. In some texts, interval and ratio measures are combined, as is the
case in Social Statistics for a Diverse Society (Frankfort-Nachmias & Leon-
Guerrero, 2009). 



SPSS/PASW Statistics uses the following codes for levels of measure-
ment: nominal, ordinal, and scale. You can select the level of measurement
from the pull down menu for each variable in the “Measure” column of the
Variable View window. “Nominal” and “Ordinal” both correspond to the
concepts with the same names. The “Scale” denotation corresponds to
interval-ratio, interval, and ratio. There are functions within the
SPSS/PASW Statistics software that will limit your ability to conduct analy-
ses or create graphs based on the recognized level of measurement.
Therefore, it is important to verify that the indicator in the “Measure” col-
umn of the Variable View is correct for all variables you will use in your
analyses.
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